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Morn ingstar  Of f ice  Academy Day  4 :  
Research  and  Workspace
OverviewWelcome to Day 4 of Morningstar Office Academy. The lessons in this document mirror the 
lessons demonstrated in the Research lesson. You will see screenshots of Morningstar and 
in some cases, text is included; you can use this supplement during the session to make 
notes and refer back to it as a training resource. 

The last section of this document lists the practical application exercises designed to help 
you put into practice key actions demonstrated in this session.

The morning session focuses on inputting client and account data. The following topics are 
covered: 

• understanding Research Settings on the Home tab
• identifying components of the Research tab
• customizing data points on the Research tab
• searching for securities, and
• generating investment graphs.

The afternoon session focuses on the Workspace tab. The following topics are covered: 

• identifying pages within the Workspace tab
• creating an investment list
• creating a custom benchmark
• creating a model portfolio, and
• reviewing other tools in the Workspace tab.
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Lesson 1: Modifying Research Settings Overview
Lesson 1: Modifying Research Settings

OverviewIn this lesson, you will learn about modifying the Research Setting options available 
from the Home tab.

What Research 
Settings are available?

Changing the default settings you use in the Research tab allows you to control such 
functions as:

• the number of decimal places shown for prices
• default settings for currency, data universe (that is, which security type do you want to 

see when you go to the Research tab) and benchmark, and
• whether extended performance is shown.

 Note: For some mutual funds, Morningstar provides adjusted historical returns and an 
Extended Performance Rating. This means any share class lacking a 1-, 3-, 5-, or 10-year 
performance history may receive a hypothetical Morningstar Rating based on the oldest 
surviving share class of the fund. First, Morningstar computes the funds' new return stream 
by appending an adjusted return history of the oldest share class. Next, the Extended 
Performance Rating is determined by comparing the adjusted-historical returns to the current 
open-end mutual fund universe to identify placement in the bell curve used to assign the 
Morningstar Rating.

Numerical Extended Performance data appears in italics, and Morningstar Ratings based on 
extended performance returns appear as hollow stars. Data points that may be calculated 
with extended performance data include trailing returns, annual returns, Morningstar Ratings, 
standard deviation, mean, and Sharpe Ratio.

On the Export tab of the Research Settings dialog box, you can elect to export the 
Morningstar Rating and Morningstar Style Box as symbols, rather than a number or 
words.
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Lesson 1: Modifying Research Settings What Research Settings are available?
You can see (and change) the Research Settings by doing the following:

1. Go to the Home tab.
2. Select the Settings page.
3. Click once on Research Preferences. The Set User Preferences dialog box opens.

4. Make any changes you like, then click OK.

From the Settings page on
the Home tab, click once 
on this option to see the 
settings for the Research tab
Version 1.0 3



Lesson 2: Identifying Components of the Research Tab Overview
Lesson 2: Identifying Components of the Research Tab

OverviewIn this lesson, you will learn about the following topics:

• how to navigate the Research tab, and
• recognizing standard data point views.

How do I navigate the 
Research tab?

When you first click on the Research tab in the left-hand navigation pane, you are 
brought to the default universe page. If you haven’t made any changes in the Settings 
area on the Home tab, this will be the Open End Funds universe. 

You can always click on another data universe to see those records. Note that you 
might need to select a sub-universe before proceeding. For instance, in the Open End 
Funds universe, you need to double-click the United States Mutual Funds row to access 
that universe. 

 Note: In order to see the Hedge Fund universe, you must first go to the menu bar at the top of 
the screen and select File…Hedge Fund Agreement. After filling out the survey and 
relaunching Morningstar Office, you will be able to see the Hedge Fund universe in the 
Research tab.

What are the standard 
data point views?

In each data universe, a series of views with selected data points are available.

Click here to see the
list of views available
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Lesson 3: Customizing the Data Point Views Overview
Lesson 3: Customizing the Data Point Views

OverviewIn this lesson, you will learn about the following topics:

• adding data points to a standard view
• remove data points from a view
• rearranging a custom view
• saving a custom view
• changing your custom default view

In addition to providing a wide range of standard views, Office allows you customize 
your own view. Once saved, this can become your default view. 

How do I add, 
remove or rearrange 
the data points for 
a standard view?

To add, remove or rearrange the data points for a view in the Research tab, click the 
Edit View icon above the grid view. The Select Data Points dialog box opens. From 
here, you can use the navigation controls to change the lineup of data points, as well as 
their order.

How do I save a 
custom view?

Once you have selected the columns you want to see, and set their order, click the 
Save button on the Select Data Points dialog box. You will be prompted to give the 
view a name.

How do I change my 
custom default view?

To change the default view you see when going to a Research universe, click the View 
drop-down field and choose Select Default View…. You can use either another 
system view, or a custom view you have created.

Use these controls 
to change the order of 
data points in a view
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Lesson 4: Searching for Securities Overview
Lesson 4: Searching for Securities

OverviewIn this lesson, you will learn about the following topics:

• using Search For to find securities
• using Locate to find securities, and
• using the Find tool.

How do I use 
the Search For tool?

The Search For tool is located in the toolbar adjacent to the menu bar. It is used to find 
securities when you know the name or ticker of the item(s) you are looking for. 

Note the following important points about using this tool:

• You can enter only one ticker or name at a time. You cannot separate items with a 
comma or the word “or.”

• If you enter a name (such as Vanguard), multiple items will be returned. The system 
will look for any items that contain the search term in the security’s name.

• The Search For tool will return only those items that match your name or ticker search, 
so the Search For tool is a good option when you are confident in what you are looking 
for, and want to isolate specific items in the grid view.

When you search in 
this field, the system 
isolates the security
you are looking for
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Lesson 4: Searching for Securities How do I use the Locate tool?
How do I use 
the Locate tool?

The Locate tool is on the toolbar above the grid view. It is used to highlight a security 
within the grid view. 

Note the following important points about using this tool:

• Clicking the Locate icon opens the Select a Security dialog box. From here, you can 
choose whether to look for an item by name or ticker, ISIN or Sec ID. 

• If looking for an item by name, you can specify whether the search should look for 
items beginning with the search term you enter, or simply contain the search term 
somewhere in the name.

• When you locate an item, the system moves to that record in the grid view and selects 
it. Therefore, the Locate tool is a good option to use when you want to select multiple 
securities without having to scroll up and down to find them.

• After locating the items you want, you can click the Selected icon below the grid view 
to show only those items.

The Locate tool allows 
you to both find and 
select items at once
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Lesson 4: Searching for Securities How do I find multiple securities at once?
How do I find multiple 
securities at once?

If you want to find multiple items by name or ticker at once, you can go to the menu bar 
at the top of the screen and select Tools…Find…Find. 

Note the following important points about using this tool:

• Selecting this option opens the Find Securities dialog box. From here, you can choose 
whether to look for an item by name or ticker, ISIN or Sec ID.

• You can look for multiple tickers at once by separating them with a comma.
• When you find an item, you can click Add or Add All to include them in the Selected 

Records area.
• When you click OK to close the dialog box, the system will isolate the securities you 

chose, but the records will not be selected.
• The Find Securities dialog box is good option to use when you have a long list of 

specific securities to find.

Follow this path to pen the 
Find Investments dialog box
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Lesson 5: Search by Criteria and Find Similar Funds Overview
Lesson 5: Search by Criteria and Find Similar Funds

OverviewIn this lesson, you will learn about the following topics:

• create a list of securities using the Search by Criteria tool, and
• create a list of similar funds using the Find Similar Funds tool.

How do I use the Search 
by Criteria tool?

The Search by Criteria tool is used when you know some aspect(s) of the securities you 
are looking for, but not the exact security. For example, you might want to see all large-
cap funds in the top 33% of their Morningstar Category, or all five-star stocks in the 
Health Care sector. You can search from hundreds of data points available for each 
universe. 

When searching for multiple criteria, you need to determine which relationship (REL) to 
use among them as follows: 

• choose And when you are looking to connect two pieces of information; or narrow 
your search

• choose Or when you want the system to read each line of criteria separately, or 
expand your search.

• choose Repeat to copy the row above and set the relationship value to OR

How do I use the Find 
Similar Funds tool?

The Find Similar Funds tool is used to filter funds with a similar performance, portfolio or 
both. This tool might be used when you are looking for a substitute fund for one that is 
closed to new investors. You can access it from the menu bar at the top of the 
Morningstar Office window by selecting Tools…Find…Find Similar Funds.

Follow this path to launch
the Find Similar Funds tool
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Lesson 6: Investment Charts Overview
Lesson 6: Investment Charts

OverviewIn this lesson, you will learn about the following topics:

• the Growth Chart
• the Risk/Reward Scatterplot
• the Correlation Matrix, and
• output options for charts. 

What does the 
Growth Chart show?

This chart shows whether the investment outperformed its category average and the 
default benchmark you choose in your settings. You can add up to 15 investments to 
the chart.

This is an example 
of the Growth chart
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Lesson 6: Investment Charts What does the Risk/Reward Scatterplot show?
What does the 
Risk/Reward 
Scatterplot show?

The Risk/Reward Scatterplot shows where the investment falls in regard to risk and 
reward in relation to your default benchmark. You can add up to 99 investments to this 
chart.

This is an example of the
Risk/Reward Scatterplot
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Lesson 6: Investment Charts What does the Correlation Matrix show?
What does 
the Correlation 
Matrix show?

The Correlation Matrix shows the positive or negative correlation of the returns of a 
group of investments. You can add up to 15 investments to the Correlation Matrix.

What can I do with the 
chart images in 
Morningstar Office?

After generating a chart, you can use one of the following output methods:

• Copy the chart image to your clipboard, to paste the chart directly into a Word 
document.

• Add the chart to a PowerPoint presentation.
• Use Create PDF or Create PDF with Disclosures to give a copy to your clients. A PDF 

with Disclosures will provide raw data.
• Export to Excel.

This is an example of
the Correlation Matrix
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Lesson 7: Identifying Tools within Workspace Overview
Lesson 7: Identifying Tools within Workspace

OverviewIn this lesson, you will learn about the pages and tools available to you in the 
Workspace tab.

What tools are 
available from the 
Workspace tab?

The table below lists the tools (and a description of each) available from the 
Workspace tab.

Item Description

Investment Lists
An investment list is a static set of securities you save. This 
saves you time from having to search for the same items over 
and over again in the Research tab.

Search by Criteria

If you save a Search by Criteria you create in the Research tab, 
you can access it here for the latest set of securities matching 
the criteria. Note that these are not static, as the investment 
lists are.

Model Portfolios

Model portfolios can save you time when it comes to creating a 
proposed lineup of securities for a client. You can also use them 
to compare existing client accounts to a recommended 
portfolio.

Asset Allocations
Asset Allocation sets allow you to target an optimal strategy for 
a client, or to show them how their current holdings are out of 
step compared to your recommendations.

Benchmarks
The Benchmarks page allows you to create custom, blended 
benchmarks comprised of multiple indexes, categories or 
securities.

Defined Contribution Plans

In addition to creating the lineup of securities for a Defined 
Contribution plan, you can also set the fees and define other 
parameters. The Plan Status and Plan Comparison reports can 
be generated as well.

Market Assumptions

Market Assumptions are used in creating Investment Plans. You 
can customize the returns and risk metrics for your own set of 
Market Assumptions, or explore the default versions available 
here.
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Lesson 8: Investment Lists Overview
Lesson 8: Investment Lists

OverviewIn this lesson, you will learn about the following topics:

• creating an Investment List from scratch
• creating an Investment List from a saved Search by Criteria, and
• creating an Investment List from an existing list.

How do I create an 
investment list?

You can create an Investment List by selecting securities in the Research tab (or from 
the result set of a Search by Criteria in the Workspace tab), then clicking 
Action…Save as…Investment List.

After selecting the items 
you want to include in a list, 
you can create it from the 
Action menu by following this path
Version 1.0 14



Lesson 9: Custom Benchmarks Overview
Lesson 9: Custom Benchmarks

OverviewIn this lesson, you will learn about the following topics:

• what kind of custom benchmarks you can create, and
• where you can apply a custom benchmark in Morningstar Office.

What kind of custom 
benchmarks can I use in 
Morningstar Office?

Benchmarks are used as a comparison mechanism. Two types of custom benchmarks 
can be used in Morningstar Office: Simple Blended and Staged Blended.

• Simple Blended Benchmarks allow you to select securities, and assign weights for one 
period of time.

• Staged Blended Benchmarks allow you to change your allocation over a specific period 
of time. For example, you could use the same set of indexes but change from a more 
aggressive allocation to a more conservative approach.

Where can I use custom 
benchmarks in 
Morningstar Office?

You can set a custom benchmark as a default benchmark in the following areas:

• Investment Plans
• client accounts (for running reports)
• Research, when generating charts and reports, and
• individual accounts, to more accurately compare the benchmark to the actual 

composition of the account. 
Version 1.0 15



Lesson 10: Model Portfolios Overview
Lesson 10: Model Portfolios

OverviewIn this lesson, you will learn about the following topics:

• the kinds of model portfolios you can create
• how to generate a Snapshot Report for a model portfolio
• how to create an account from a model portfolio, and
• how to create a model portfolio from an account.

What kind of model 
portfolios can I create in 
Morningstar Office?

Two types of model portfolios can be created in Morningstar Office:

• Static Models, which represent an investment strategy for one period of time. Static 
Models allow you to rebalance monthly.

• Variable Models, which represent an investment strategy at multiple periods of time, 
by creating multiple versions of your model at different time periods. Variable models 
allow you to select a buy-and-hold strategy, or several different rebalancing options. 
You would rebalance using the most current version of the model. 

How do I generate a 
Portfolio Snapshot 
report for a model 
portfolio?

Running a Snapshot Report for a model portfolio helps determine whether the model 
matches the benchmark. To generate the Snapshot Report for a model portfolio, do the 
following:

1. From the Static Models or Variable Models page under the Benchmark tab, select the 
model you want to use.

2. From the Action menu, select Reports…Analytical…Snapshot.
3. Complete the settings you want in the Snapshot Report Options dialog box, then click 

OK.

How do I create 
an account from 
a model portfolio?

You can save a model portfolio as a client account. To do this, do the following:

1. From the Static Models or Variable Models page under the Benchmark tab, select the 
model you want to use.

2. From the Action menu, select Utilities…Save As…Accountpf.
3. Select the client you want to save the portfolio to, then click OK.
4. Decide whether this will be a Quick Account or Transactional Account, then 

click OK.
5. Fill out the Account Profile dialog box, then click Next.
6. Make any changes you want to the holdings or allocation, then click Finish.

How do I create 
a model portfolio 
from an account?

You can also use a client’s account as the basis for a model portfolio. To do this, do the 
following:

1. From the Accounts page on the Portfolio Management tab, select the account you want 
to use for the model.

2. From the Action menu, select Utilities…Create model from account.
3. Click OK when the confirmation message appears. The account is now available on the 

Static Models page on the Workspace tab.
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Practical Application Exercises Overview
Practical Application Exercises

OverviewThese exercises put into practice topics learned during Search Session. Please take the 
time to complete each exercise.

Exercise 1:
Customize a Data View

You can create a custom data view in the Research tab, where you choose both the 
columns for the view, and the order in which they appear. This allows you to mix and 
match data points from various views for a universe.

1. Go to the Research tab, and go to the United States Mutual Fund universe.
2. From the View drop-down field, select Returns (Year-End).
3. Click the Edit View icon.
4. Make sure Find Data Point by View is selected, and be sure Snapshot is the view.
5. From the Available Data Points area, select Ticker, then click Add.
6. From the Available Data Points area, select Morningstar Category, then click Add.
7. In the Selected Data Points area, select Ticker, then use the arrow buttons to move it 

after Name. 
8. From the Available Data Lists area at the top of the dialog box, select the Name 

Containing option button for the Find Data Point by area.
9. In the search field, type Socially, then click Go.
10. Select the data point that appears, then click Add.
11. Click Save at the bottom of the dialog box. The Save As dialog box opens.
12. In the name field, type Socially conscience and Year End, then click OK.

Exercise 2:
Create a 
Search by Criteria 

This search will look for four- and five-star rated small-cap funds. Do the following:

1. Go to the Research tab, and go to the United States Mutual Fund universe.
2. Click the Search icon on the toolbar above the grid view.
3. Click on the Field Name for the first row and select Morningstar Category.
4. The Operator should be =.
5. From the Value field, select Small Growth.
6. Click Run Search.
7. For the second row, set the following parameters:

• the Rel column should be Or
• the Field Name should be Morningstar Category
• the Operator should be =
• the Value should be Small Value

8. Click Run Search.
9. For the third row, set the following parameters:

• the Rel column should be Or
• the Field Name should be Morningstar Category
• the Operator should be =
• the Value should be Small Blend

10. Place an open parenthesis before Small Value and a closed parenthesis after Small 
Blend.

11. For the fourth row, set the following parameters:
• the Rel column should be And
• the Field Name should be Morningstar Rating Overall
• the Operator should be >=
• the Value should be 4
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12. Click Run Search.

13. Click the Save As icon at the top of the Search Criteria dialog box.
14. In the Name field, type Small Cap and 4 Stars.
15. Click OK. 

Exercise 3:
Generate the 
Growth Chart

1. Go to the Research tab, and go to the United States Mutual Fund universe.
2. Select up to 15 securities.
3. From the Action menu, select Charts…Growth.
4. Click the Clipboard icon above the chart, and paste the image into a Word document.

Exercise 4:
Generate the Risk/
Reward Scatterplot

1. Go to the Research tab, and go to the United States Mutual Fund universe.
2. Select up to 99 securities.
3. From the Action menu, select Charts…Risk/Reward.
4. Click the PowerPoint icon above the chart, and paste the image into a presentation.

Exercise 5:
Generate the 
Correlation Matrix

1. Go to the Research tab, and go to the United States Mutual Fund universe.
2. Select up to 15 securities.
3. From the Action menu, select Charts…Correlation Matrix.
4. Click the Create PDF icon. 

Exercise 6:
Create an
investment list from 
a Search by Criteria

After viewing the results of a Search by Criteria you saved, you can select items and 
save them to a static investment list. Do the following:

1. Go to the Workspace tab.
2. Expand the Search Criteria folder and select My Search Criteria.
3. Double-click on Small Cap and 4 Stars. (The one you saved from Exercise 2.)
4. Click the checkbox in the header row above the grid area; this will select all items.
5. From the Action menu, select Save As…Investment List.
6. In the Name field, type Small Cap and 4 Stars.
7. Click OK.

This is what the 
Search Criteria dialog box 
should look like
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Exercise 7:
Create a simple 
blended benchmark

To create a simple blended benchmark, do the following:

1. Go to the Workspace tab.
2. Select the Benchmarks page.
3. Click the New icon above the grid view. The Custom Benchmark dialog box opens.
4. In the Benchmark Name field, type Moderate Allocation.
5. In the Benchmark Type field, be sure Simple Blended Benchmark is selected.
6. Click Next.
7. To add holdings, click the + Add icon. The Add Holdings dialog box opens.
8. From the Universes field, select Popular Indexes in USD.
9. Click Go.
10. Select the following indexes:

• Morningstar Core Bond MCBI TR
• Russell 2000 TR USD, and
• S&P 500 Growth TR.

11. From the Universes field, expand the Morningstar Category option and select Open-
End Categories.

12. Click Go.
13. Select US OE Foreign Large Growth.
14. Click OK.
15. Back in the Holdings Entry window, choose Enter By…Weight.
16. Set the Weights% as:

• Morningstar Core Bond MCBI TR = 30
• Russell 2000 TR USD = 10
• S&P 500 Growth TR = 40
• US OE Foreign Large Growth = 20

17. Click the Recalculate button at the bottom of the window.
18. Click Finish.

Exercise 8:
Additional 
Benchmark Activities

To set a custom benchmark as a default benchmark for investment plans, do the 
following:

1. From the menu bar at the top of the Morningstar Office window, select 
Tools…Settings…Set Default Planning Benchmark.

2. Click Magnifying glass icon.
3. From the Within drop-down field, select Custom Benchmark.
4. Click Go.
5. Choose the Moderate Allocation benchmark you created in Exercise 7.
6. Click OK.
7. Click OK on the Set Default planning Benchmark dialog box.

To apply a benchmark to a specific account, do the following:

1. Go to the Client Management tab.
2. Double-click a client record.
3. Right-click on an account.
4. Select Edit Account Settings.
5. In the Primary Benchmark field, click the drop-down field and choose Select 

Benchmark. 
6. From the Within drop-down field, select Custom Benchmark.
7. Click Go.
8. Choose the Moderate Allocation benchmark you created in Exercise 7.
9. Click OK.
10. Click Save.
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Exercise 9:
Create a Static 
Model Portfolio

To create a static model portfolio, do the following:

1. Go to the Workspace tab.
2. Expand the Model Portfolios folder and select Static Models.
3. Click the New icon above the grid view.
4. In the Model Name field, type Moderate Allocation Strategy.
5. Click the magnifying glass icon in the Attached Asset Allocation field.
6. Click Go.
7. Select the Moderate (M*C) allocation.
8. Click OK.
9. From the Benchmark drop-down field, choose Select Benchmark. 
10. From the Within drop-down field, select Custom Benchmark.
11. Click Go.
12. Choose the Moderate Allocation benchmark you created in Exercise 7.
13. Click OK.
14. Click Next
15. Click the + Add icon.
16. Enter the following tickers directly into Symbol field:

• GIGIX
• FRDPX
• HHBUX, and
• MFGSX.lw.

17. Click the Enter By drop-down field and select Weight.
18. Enter the following weights:

• GIGIX = 20
• FRDPX = 45
• HHBUX = 10
• MFGSX.lw = 25

19. Click Recalculate at the bottom of the Holdings Entry window.
20. Click Finish.

Exercise 10:
Create a Portfolio 
Snapshot report 
to compare a
benchmark to
a model portfolio

To compare a benchmark to a model portfolio, do the following:

1. Go to the Workspace tab.
2. Expand the Model Portfolios folder and select Static Models.
3. Double-click the Moderate Allocation Strategy model.
4. From the menu bar at the top of the model window, select Reports…Analytical 

Reports…Snapshot.
5. Click OK on the Snapshot Report Options dialog box.
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